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Removed chapter on Migrations
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About This Guide
This document provides design considerations and guidelines for deploying network solutions that include
the Unified Intelligence Center.

Audience
This design guide is intended for system architects, designers, engineers, and Cisco channel partners who
want to apply best design practices for Unified Intelligence Center. This document assumes that you are
familiar with the Cisco Systems product with which you intend to integrate Unified Intelligence Center.
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Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, using the Cisco Bug Search Tool (BST), submitting a service
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To receive new and revised Cisco technical content directly to your desktop, you can subscribe to the What's
New in Cisco Product Documentation RSS feed. RSS feeds are a free service.
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Before You Install
• About Cisco Unified Intelligence Center, page 1
• Prerequisites and Important Considerations, page 2
• Configuration Worksheet, page 2
• Installation Sequence and Time, page 4
• Installation Wizard Navigation, page 4

About Cisco Unified Intelligence Center
Unified Intelligence Center can be installed as a standalone server or as a cluster of a maximum of eight server
nodes. There is one mandatory publisher node (called the Controller) and a maximum of seven subscriber
nodes (called Members). The Controller node includes a Member; thus a deployment can consist of a Controller
only.
All nodes must meet latency requirements as described in the Cisco Unified Intelligence Center Solution
Reference Network Design (SRND) Guide.
The primary node (the Controller) includes both the Administration (Operations, Administration, Maintenance,
and Provisioning or OAMP) and the Unified Intelligence Center Reporting web applications. A Controller is
required in all deployments. A deployment can consist of a Controller only.
The Member nodes have the Unified Intelligence Center Reporting web application only.
Unified Intelligence Center is installed on Cisco Unified Voice Operating System (VOS). This is an appliance
model or "closed box" and does not support navigation into, or manipulation of, the file system.
Unified Intelligence Center must be installed on a Virtual Machine running over UCS B-Series and C-Series
Servers or equivalent hardware.
The disk capacity and hardware type of Member nodes should be equal to or greater than those of the Controller
node.
For Cisco Unified Intelligence Center Hardware and Software Specification, refer Compatibility Matrix for
Unified CCE and Unified CCX.
See the Cisco Unified Intelligence Center Solution Reference Network Design (SRND) Guide, available in
the Design Guides category at http://www.cisco.com/c/en/us/support/customer-collaboration/
unified-intelligence-center/tsd-products-support-series-home.html.
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Prerequisites and Important Considerations
Before you proceed with the installation and upgrade, note these important requirements:
• You must have access to a Network Time Protocol (NTP) server.
• You must have a pre-configured default router.
• You must have a pre-configured Domain Name Server (DNS).
• You must install the primary node (the Controller).
• Request a license file from Cisco Systems, Inc. See . When the primary node installation Acquire Your
License, on page 49 is complete, and before installing a Member node, you must sign in to the
Administration console to apply for the license and to define the Member node.
• All configured nodes in a cluster must be installed and started before you install a new node. For example,
if the Controller and one Member have been installed and you are about to add a second Member, the
Controller and first Member must be started and available so that the second Member is able to access
them.
• Installation on an existing (re-purposed) server formats the hard drive and erases all data. It might also
change the system Basic Input Output System (BIOS), firmware, and Redundant Array of Inexpensive
Disks (RAID) configuration.
• On the installation configuration screens:
◦Values—such as host names, User IDs, and passwords—are case-sensitive.
◦You must enter the same security password on all nodes in the cluster. Keep a record of this
password; you will need to use it if you replace or add a server in the future or if you want to
replace the old security password with a new one.
◦Use the default Maximum Transmission Unit (MTU) setting, for all nodes in the cluster.

Note

Default value of multicast group IP address is 224.2.2.3. However it can be replaced
with any IP address within the range of 224.0.0.0 and 239.255.255.255.

Configuration Worksheet
Use this worksheet to record network and password information that the basic installation configuration wizard
prompts you to enter. Store this worksheet information for future reference.
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Table 1: Configuration Worksheet

Configuration Data

Your Entry

Host Name

Controller
Member 1
Member 2

IP Address

Controller
Member

Gateway (GW) Address

—

Primary DNS IP Address

Controller
Member

Secondary DNS IP Address

Controller
Member

Domain

—

Username

—
Note

System Administrator Password

Ensure that you use the same System Administrator
credentials for all nodes.

—

Timezone
Use the same Timezone for all
nodes.

—

Certificate Information

Organization
Unit
Location
State
Country
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Configuration Data

Your Entry

NTP Server Host Name or IP
Address

NTP Server 1
NTP Server 2
NTP Server 3
NTP Server 4
NTP Server 5

Database Access Security Password Security Password
Servers in the cluster use the security password to communicate with
one another. The security password is also used by the Disaster
Recovery System (DRS) for encryption of the backup file.
Note

You must enter the same security password for all servers in
the cluster.

Simple Mail Transfer Protocol
(SMTP) Location Host Name

SMTP Host Name or IP Address

Credentials

Application User ID
Application User Password
The Application User defined during the Controller installation is the
only credential recognized by Unified Intelligence Center.
Note

Ensure that you use the same System Application credentials
for all nodes.

Installation Sequence and Time
A Unified Intelligence Center can include one or multiple nodes. The installation for each node can take about
an hour. For most of that time, it can run unattended.
You must perform the installation on the primary node/Controller first.
Some configuration and installation processes differ slightly for the first node (Controller) and for the Members.
This is noted in these instructions.

Installation Wizard Navigation
Much of the installation requires no action on the part of the person who runs it. When user input is required,
use the following keyboard navigation and selection actions.
The installation wizard screens do not recognize a mouse or a touchpad.
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Table 2: Installation Wizard Navigation

To Do This

Press This Key

Move to the next field

Tab

Move to the previous field

Alt-Tab

Choose an option

Spacebar

Scroll up or down a list

Up or Down arrow keys

Go to the previous screen

Tab to Back and press the Spacebar

Get information on a screen

Tab to Help and press the Spacebar

Scroll up and down a list

Up or Down arrow keys
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Preparation for Unified Intelligence Center
Installation on a Virtual Machine
You can perform a fresh installation or upgrade of Unified Intelligence Center on supported virtual machines.
Also, you can perform an upgrade from previous versions to 11.0(1), by first upgrading Unified Intelligence
Center to 10.x and then to 11.0(1). For more information see About Upgrades.
• Install VMWare ESXi, page 7
• Deploy Unified Intelligence Center Open Virtualization Format/Open Virtual Appliance (OVF/OVA)
Template, page 8
• Specify Location of Unified Intelligence Center Installable, page 9
• Set Boot Order, page 9
• Install Cisco Unified Intelligence Center on Virtual Machine, page 10

Install VMWare ESXi
Before you begin your Unified Intelligence Center installation, you must install VMware ESXi and configure
the virtual server.

Note

Release 11.0(1) is supported only on VMware ESXi 5.1 and 5.5 versions.
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Procedure
Step 1
Step 2
Step 3

Step 4

Refer to Unified Communication Virtualization to install, setup, and configure the UCS Hardware.
Configure the UCS Network. See UCS Network Configuration for more information.
Use the instructions mentioned in the http://docwiki.cisco.com/wiki/Unified_Communications_
Virtualization#How_to_Deploy to install VMWare ESXi 5.1 and 5.5 on your UCS B-series and C-series
server.
After ESXi is installed successfully, reboot the server.

Deploy Unified Intelligence Center Open Virtualization
Format/Open Virtual Appliance (OVF/OVA) Template
Open Virtualization Format/Open Virtual Appliance (OVF/OVA) is an open standard for packaging and
distributing virtual appliances. Files in this format have an extension of .ova. The naming convention for the
OVF/OVA template is PRODUCT_COMPONENT_USER COUNT_VERSION_VMVER.ova.
The OVF/OVA template defines the configuration of the virtual machine hardware. The configuration of a
Cisco Unified Communications application virtual machine must match a supported virtual machine template.
This section describes the steps to deploy a Unified Intelligence Center OVF/OVA template on the virtual
machine.

Procedure
Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8
Step 9

Log in to ESXi using VMWare Vsphere or any other compatible client.
Highlight the host or cluster to which you want to deploy the Virtual Machine.
Select File > Deploy OVF/OVA Template.
Click Deploy from File and specify the name and location of the OVF/OVA file (with a .ova extension)
Alternatively, you can click Deploy from URL and specify the URL of the OVF/OVA file.
Click Next.
Verify the details of the template, and click Next.
Specify a name for the Virtual Machine that you are about to create and choose an inventory location on
your host.
Click Next.
Verify the deployment settings, and click Finish.
The virtual machine that you added is listed under the UCS server tree in the vSphere Client home page.
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Specify Location of Unified Intelligence Center Installable
Procedure
Step 1
Step 2
Step 3
Step 4

Step 5

Select the newly added Virtual Machine.
From the Inventory menu, select Virtual Machine > Edit Settings.
In the Hardware tab, select CD/DVD Drive 1.
Select one of the following options to specify the location where you have the bootable Unified Intelligence
Center installer file:
a) Client Device – If you want to use the CD/DVD drive on the client machine from where you are accessing
the virtual machine remotely.
b) Host Device – If you want to use the CD/DVD drive on the ESXi host machine.
c) Datastore ISO file – If you want to use the datastore on the virtual machine. Before using this option,
ensure that the Bootable iso image of Unified Intelligence Center is copied to the datastore of the ESXi
host.
Note
Ensure that you set the boot order by making CD ROM the first device upon power up. For details,
refer to Set Boot Order.
Click OK to save and close the Virtual Machine Properties window.

Important: Make sure that you have copied or inserted the CD/DVD with the Unified Intelligence Center
installable in the appropriate location before you proceed with the next step.

Set Boot Order
To set the boot order:

Procedure
Step 1

From the Inventory menu, select Virtual Machine > Edit Settings.
The Virtual Machine Properties window appears.

Step 2
Step 3

In the Options tab, select Boot Options.
Select Force BIOS Setup.
Note
When you restart the Virtual Machine, you will see the BIOS screen in the VM console
tab.
In the BIOS screen, select Boot Options > make the CD/DVD ROM as the first device for bootup.
Click Save.

Step 4
Step 5
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Install Cisco Unified Intelligence Center on Virtual Machine
Procedure
Step 1
Step 2

Select the virtual machine and click Power > Power On from the shortcut menu. Alternatively, from the
Inventory menu, select Power > Power On.
The virtual machine powers on and Unified Intelligence Center installation starts up automatically. Follow
the steps mentioned in Installation-All Nodes to complete the Unified Intelligence Center installation.
When using Unified Intelligence Center on the UCS Servers, note the following:
• The answer file generated by the Answer File Generator (platformConfig.xml) is not readable from a
USB key. The Answer File Generator generates a floppy image [FLP - virtual floppy] for performing
an unattended installation.
• USB tape backup is not supported. Use SFTP instead.
• Install logs are written only to the virtual serial port.
• Unattended installs use virtual floppy instead of USB.
• Boot order is controlled by the BIOS of the VMware VM.
• Hardware BIOS, firmware, and drivers must be the required level and configured for compatibility with
Unified Intelligence Center-supported VMware product and version.
Note

vSphere provides you with a console that you can use to provide inputs during the installation. To
open the console, select the virtual machine from the vSphere home page and click Open Console
from the shortcut menu. Alternatively, select the virtual machine and click the Console tab in the
right pane of the vSphere home page. Pointing and clicking anywhere in the console window will
allow you to enter data in the console. Once you start working on the console, the mouse is locked
and you can no longer use it. Use Tab key to navigate and use the Enter button to commit the values
you entered. To release the mouse from the console window, press Ctrl + Alt.
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Installation — All Nodes
• Installation Media, page 11
• Before You Begin, page 11
• Enter Pre-Existing Configuration Information, page 13
• Configure Basic Install, page 13
• Live Data Post-Install Configuration , page 15

Installation Media
The installation for Unified Intelligence Center is delivered on DVD media. Run the DVD installation on
each node, and use the same DVD for all nodes.

Note

All nodes must be running the same version of Cisco Unified Intelligence Center.

Before You Begin
Every installation begins with an optional pre-install media check, which includes a hardware check. You
then make your product deployment selection before continuing to the basic install configuration.

Procedure
Step 1

Insert the installation DVD into the tray. Then restart or power on the server so that it boots from the DVD.
You see messages as the pre-install script runs. When the pre-install script ends, the DVD Found screen
opens.

Step 2

In the DVD Found screen, you have the option to perform a media check to verify the integrity of the DVD.
If you want to check the media:
1 Select Yes to begin the verification of the media integrity.
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Note

The media check can take up to an hour. If the media check for the Controller passes, you can
safely skip the media check when you install the Members.

2 If the media check passes, select OK. The Product Deployment Selection screen appears, and you can
continue to Step 3.
If the media check fails, the DVD is ejected and the installation terminates. Contact your support provider
for assistance.
If you want to skip the media check:
1 Select No. The Product Deployment Selection appears.
2 Proceed to Step 3.
Step 3

Choose one of the following options:
• Cisco Unified Intelligence Center
• Live Data
• Cisco Unified Intelligence Center with Live Data — This option is required for installation in a
Packaged CCE environment.

Step 4

Click OK to initiate a check for hard drive sanity, during which the installation checks for a supported hardware
platform with the correct number of disks.
A successful hardware check opens the Proceed with Install screen. The Proceed with Install screen shows
the version of the product that is currently on the hard drive (if any) and the version of the product that is on
the DVD. For the initial installation, the version on the hard drive shows NONE.
If the server hardware is unsupported, a message appears indicating that the installation cannot
proceed, and the installation halts. If you require assistance understanding the message, write it down
to facilitate your conversation with your support provider. Refer http://docwiki.cisco.com/wiki/
Compatibility_Matrix_for_Unified_CCE for details on supported hardware.
Select Yes on the Proceed with Install screen.
The Platform Installation Wizard screen appears.
In the Platform Installation Wizard screen, select Proceed to open the Apply Patch screen.
Select No at the Apply Patch screen. Do not apply patches from the Installation wizard. Refer to About
Upgrades, on page 29 for instructions on upgrading Unified Intelligence Center software with Engineering
Specials, Minor Releases, and Maintenance Releases.
Your selection of No opens the Basic Install screen.
Note

Step 5
Step 6
Step 7

If you select Yes by mistake and open the Apply Patch screen, select Back. Then choose one of the following
options:
• To enter your configuration information manually and have the installation program install the configured
software on the server, choose Proceed and continue with this procedure.
• To do any of the following tasks, choose Skip; then continue with the Enter Pre-Existing Configuration
Information procedure:
• Manually configure the software that is preinstalled on your server — In this case you do not need
to install the software, but you must configure the preinstalled software.
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• Perform an unattended installation — In this case, you provide preexisting configuration information
on a USB key or floppy disk.
• Install the software before manually configuring it — In this case the installation program installs
the software, then prompts you to configure it manually. You can choose Skip if you want to
preinstall the application on all your servers first and then enter information at a later time. This
method might cause you to spend more time performing the installation than the other methods.
Step 8

Select Continue at the Basic Install screen to enter the configuration screens.

Enter Pre-Existing Configuration Information
Start here if you have a server that has the product pre-installed or if you chose Skip in the Platform Installation
Wizard window.

Procedure
Step 1
Step 2

After the system restarts, the Pre-existing Installation Configuration window displays.
If you have pre existing configuration information (Created by Answer File Generator) in a floppy disc or a
USB key, insert the disc or the USB key now and choose Continue. The installation wizard will read the
configuration information during the installation process.
Note
If a popup window states that the system detected new hardware, press any key and then choose
Install from the next window.
The Platform Installation Wizard window displays.

Step 3
Step 4

To continue with the Platform Installation Wizard, choose Proceed.
In the Basic Install window, choose Continue. Continue with the "Configure basic install" section.

Configure Basic Install
The basic install launches a series of screens that present questions and options pertinent to the platform and
the setup configuration. There is online help for each wizard screen.

Note

You can change many of the basic installation configuration settings after the installation using the Set
commands in the Command Line Interface (CLI). The CLI is documented in the Administration Console
User Guide for Cisco Unified Intelligence Center.
The first Basic Install wizard screen is Timezone Configuration.
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Procedure
Step 1

In the Timezone Configuration screen:
a) Use the down arrow to select the local timezone that most closely matches where your server is located.
You can also type the initial character of the timezone to move to that item in the list. The timezone field
is based on country/city and is mandatory. Setting it incorrectly can affect system operation.
Note
Use the same timezone for all
nodes.
b) Select OK to open the Auto Negotiation Configuration screen.

Step 2

In the Auto Negotiation Configuration screen, select whether or not you want to use automatic negotiation
for the settings of the Ethernet network interface card (NIC).
If

Then

You want to disable auto-negotiation and specify NIC
speed and duplex settings.

Select No to open the NIC Speed and Duplex
Configuration screen, where you can manually
configure the settings.
Proceed to Step 3.

The ethernet network interface card (NIC) attached to
your hub or Ethernet switch supports automatic
negotiation.

Proceed to Step 4.

Step 3

In the NIC Speed and Duplex Configuration screen, configure settings as follows:
a) Specify the speed of the Network Interface (NIC) card in megabits per second. Speed options are 10 or
100.
b) Specify the duplex setting of the server NIC. Options are Full or Half.
c) Select OK to open the MTU Configuration screen.

Step 4

In the MTU Configuration screen, select No to keep the default setting for Maximum Transmission Units
(1500). If you do not accept the default and configure the MTU size incorrectly, your network performance
can be affected.
Your selection of No opens the DHCP Configuration screen.

Step 5
Step 6

In the DHCP Configuration screen, select No to open the Static Network Configuration screen.
At the Static Network Configuration screen, enter static network configuration values as follows, referring
to the Configuration Worksheet if necessary:
a) Enter the Host Name.
b) Enter the IP Address.
c) Enter the IP Mask.
d) Enter the GW Address,
e) Select OK to open the Domain Name System (DNS) Client Configuration screen.

Step 7

Select Yes to enable the Domain Name System (DNS) Client.
Enter your DNS client information as follows, referring to the if necessary:
a) Configuration Worksheet Enter the Primary DNS (mandatory).

Step 8
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b) Enter the Secondary DNS (optional).
c) Enter the Domain (mandatory).
d) Select OK to open the Administrator Login Configuration screen.
Step 9

In the Administrator Login Configuration screen:
a) Enter the ID for the System Administrator.
b) Enter and then confirm the password for the administrator.
c) Select OK to open the Certificate Information screen.

Step 10 In the Certificate Information screen:
a) Enter data to create your Certificate Signing Request—Organization, Unit, Location, State, and Country.
b) Select OK to open the First Node Configuration screen. ("Is this server the First Node in the cluster?")
Step 11 In the First Node Configuration screen, specify whether you are configuring the first node (the Controller).
If

Then

You are installing and configuring the Select Yes to open the Network Time Protocol Client Configuration
primary node (the Controller).
screen.
Continue to Controller Configuration.
You are installing and configuring a Select No to open the First Node Configuration Warning screen.
secondary node (a Unified Intelligence
Continue to Complete Configuration for Member Node .
Center Member).

Live Data Post-Install Configuration
If you choose to install Unified Intelligence Center with Live Data, you must also perform some Live Data
configuration tasks. Refer chapter 4 on Live Data Installation in the Cisco Unified Contact Center Enterprise
Installation and Upgrade Guide http://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-installation-guides-list.html.
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Controller Configuration
• Complete Configuration for First Node, page 17

Complete Configuration for First Node
When you complete the basic install configuration and select Yes to indicate that you are installing the first
node, perform the following steps to complete the configuration for the Controller.
The first screen you see is the Network Time Protocol Client Configuration screen.
This screen gives the option of setting the time for the first node (the Controller) from a time that you set on
the Hardware Clock screen - or - from an external Network Time Protocol server that you define.

Note

NTP server configuration is mandatory and is set for the first node. Other nodes set their time to the time
on the first node.

Procedure
Step 1

Select Yes at the Network Time Protocol Client Configuration screen.
The Network Time Protocol Client Configuration screen opens.

Step 2

Enter the IP address, NTP server name, or NTP Server Pool name for at least one external NTP server.
You can add up to five NTP servers and make changes to the NTP server list at a later time.
You should use a minimum of three external NTP
servers.
When you complete the NTP configuration, select OK.
The Security Configuration screen opens.
Note

Step 3
Step 4

In the Security Configuration screen:
a) Enter the Database Access Security password. This is the password that servers in the cluster use to
communicate with each another. You must enter the same security password for all servers.
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b) Select OK to open the SMTP Host Configuration screen.
Step 5

In the SMTP Host Configuration screen, select whether you want to configure an SMTP host to receive
platform-level emails, for example, emails about certificate expiration. This field is optional. You will configure
email for report scheduling in the Administration console.
If

Then

You want to configure an SMTP Host.

Select Yes to open the second SMTP screen opens.
Proceed to Step 6.

You do not want to configure an SMTP Host.

Select No to open the Application User Configuration
screen.
Proceed to Step 7.

Step 6

In the second SMTP Host Configuration screen:
a) Enter the hostname or IP address for the SMTP server.
b) Select OK to open the Application User Configuration screen.

Step 7

Complete the Application User Configuration screen. The application user for the Controller becomes the
System Application User and the default Super User.
Note
Although it is possible to enter unique Application User credentials on each installed node, you should
enter the same Application User Name and password on all nodes. The Application User credentials
entered during the Controller installation are the only ones recognized by Unified CCE.
a) Enter the application username.
b) Enter and confirm the application user password.
c) Select OK to open the Platform Configuration Confirmation screen. This screen states that the platform
configuration is complete.

Step 8

In the Platform Configuration Confirmation screen, select OK.
The installation begins. The system displays a Virtual Machine Question message about a locked CD-ROM
door.
In the Virtual Machine Question message, click Yes and click OK to continue the installation.
The system displays a reboot message. After the reboot, the system automatically proceeds with the installation.

Step 9
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Installation
• Installation Duration, page 19
• Installation Processes, page 19
• Installation Failure, page 21
• After Installation, page 21

Installation Duration
The installation can take from 60 to 75 minutes to complete and can run unattended for most of that time.

Installation Processes
During the installation, the monitor shows a series of processes, as follows:
• Formatting Progress Bars
• Copying File Progress Bar
• Platform Installation Progress Bars (as multiple packages are installed)
• Post Install Progress Bar
• Application Installation Progress Bars (multiple packages are backed up to the archive directory)
• An informational screen saying that the system reboots.

Note

At the start of the reboot, the CD tray holding the DVD ejects. This is normal. You can
remove the DVD.

• A System Reboot, which includes a second hardware check.
Messages appear during the reboot, some of which prompt you to press a key. Do not respond to these
prompts to press a key.
• Application Pre Install Progress Bars
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• Configure and Setup Network Progress Bars

Note

If a Network Connectivity Failure screen opens during the Configure and Setup Network
process, click Review. Then click OK at the Errors screen. Follow the prompts to reenter
your hostname, IP Address, and so forth. The installation continues when the connection
information is complete.

• Member Nodes only - Connection Validation message.
• Security Configuration
• Member Nodes only - A screen stating that there is a successful connection to the first node (select
Continue).
• The SMTP Host Configuration screen(s). Select Yes or No, according to your preference.
• Platform Configuration Complete screen. Select OK.
• Display of the Product Licensing screen.
Figure 1: License Screen

This screen shows the URL for obtaining the license (https://tools.cisco.com/SWIFT/Licensing/
PrivateRegistrationServlet) and the Media Access Control (MAC) address. Write down this address;
you need it for the license application.

Note

The screen appears briefly. If you do not have time to write down the MAC address
before the screen close, see the Frequently-asked-questions section.
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Note

This screen does not appear during Live Data only installation.

• Display of Cryptographic Information screen.
Figure 2: Cryptographic Screen

• Application Post-Install Progress Bars
The installation ends at a login prompt, at which you can enter CLI commands.
To access the web interface, you need to open a browser and enter the URL http://Controller hostname or
IP/oamp and User ID/Password of the System Application user.

Installation Failure
Insert the DVD into the tray and perform all steps in Chapter 2, and proceed to Configure Basic Install.
If a critical error occurs during installation, you are prompted to collect log files. To do this, insert a USB
memory key in any available USB port and follow the instructions on the screen.
If the installation fails over a Virtual Machine. For more information, see the topic Frequently asked Question
section.

After Installation
The action to take after the installation, depends on the type of node you installed.
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Note

After installing the Unified Intelligence Center, you can download the Unified CCE templates from cisco
website. You can then import these templates to Unified Intelligence Center.
If

Then

If you have installed a Controller, and your cluster
consists of a Controller node only

The installation is complete.
1 Open a browser and enter the URL for your
Controller ( http://Controller hostname or
IP/oamp). This opens the Administration Console.
Sign in using the System Application credentials.
2 Upload License.

If you have installed a Controller, and you intend to
1 Open a browser and enter the URL for your
install a Member
Controller ( http://Controller hostname or
IP/oamp). This opens the Administration Console.
2 Sign in using the System Application credentials.
3 Upload License.
4 Define Member Node in Administration Console
in the Administration console.
If you have installed a Member node

Open a browser and enter the URL for your Member
http://Member hostname or IP/cuic. This opens the
Unified Intelligence Center Reporting web page.
Sign in using the System Application credentials.
Until other users are added or integrated, the System
Application user has full access to the Unified
Intelligence Center Member nodes.

Note

The action above is not applicable for Live Data only installation.
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Administration Console Sign-In
After you install the Controller, you must sign in to the Administration Console to perform tasks as explained
in this chapter.

Note

The tasks below are not applicable for a Live Data only deployment.
To sign in, open a browser and enter the URL for your Controller (http://<HostAddress>/oamp), where
HostAddress is the host name or IP Address of the Controller. This opens the Administration Console.
Sign in using the System Application credentials.
• Upload License, page 23
• Define Member Node in Administration Console, page 23
• Verify Controller Is Synchronized with NTP Server, page 25

Upload License
You have limited functionality on the Administration Console and no access to the Unified Intelligence Center
Reporting interface until you upload the license file. To upload the license:

Procedure
Step 1
Step 2

Sign in to the Administration Console and select Cluster Configuration > License Management.
Select Upload license file (Browse) and navigate to the local directory where your license is stored. Then
click Apply License to load the license.

Define Member Node in Administration Console
If you intend to add a Member node, you must define the Member in the Administration console before you
run the installation for the Member.
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Procedure
Step 1
Step 2
Step 3

To access the Administration console, direct a browser to the URL http://<HOST ADDRESS>/oamp where
HOST ADDRESS is the IP Address or Hostname of your server.
Sign in using the system application user ID and password that you defined during installation. Refer to your
Configuration Worksheet, on page 2.
From the panel in the left, select the Device Management drawer. Then select Device Configuration.
Figure 3: Device Configuration

The Device Configuration page shows the Controller that you have installed. Note that the hostname defaults
to the alias CUIC1. (You can change it.)
Step 4
Step 5
Step 6

On the Device Configuration page, click Add Member.
On the Device Configuration fields for the new Member, enter a name by which you can identify the Member,
the hostname or IP address, and a description for the device.
Click Save.
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The Member appears on the Device Configuration list.
Figure 4: Member Configured

Verify Controller Is Synchronized with NTP Server
Make sure that the Network Time Protocol (NTP) on the Controller node is synchronized with the NTP server
before you install the Member node.
To do this:

Procedure
Step 1

Access the Command Line Interface on the Controller node directly, by using the monitor and keyboard at
the server console. At the login prompt:
a) Enter the ID for the System Administrator user (created during Basic Install configuration).
b) When prompted, enter the password for the System Administration user.

Step 2

Enter this command: utils ntp status.
The output must indicate that the node is synchronized with an NTP server. If the Controller node is not
synchronized with an NTP server, the installation of the Member node will fail.

Now that the Member is defined in Device Configuration and the NTP synchronization is verified, you can
begin to configure and install that member. See Installation and Configuration for Member Node.
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Member Configuration
• Installation and Configuration for Member Node, page 27
• Complete Configuration for Member Node, page 27

Installation and Configuration for Member Node
Note

All configured nodes in a cluster must be up and running before you install a new Member node.

Note

To add a member node in a Live Data only deployment, see Live Data Installation chapter 4, in the Cisco
Unified Contact Center Enterprise Installation and Upgrade Guide http://www.cisco.com/c/en/us/support/
customer-collaboration/unified-contact-center-enterprise/products-installation-guides-list.html

Complete Configuration for Member Node
Procedure
Step 1

Install the member node following the steps in Preparation for Unified Intelligence Center Installation on a
Virtual Machine, under sections:
• Deploy Unified Intelligence Center Open Virtualization Format/Open Virtual Appliance
(OVF/OVA)Template
• Specify Location of Unified Intelligence Center Installable, on page 9
• Install Cisco Unified Intelligence Center on Virtual Machine, on page 10

Step 2

At the First Node Configuration Screen, select No.
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The First Node Configuration Warning screen opens. This screen advises you that you must configure the
server on the first node before you can proceed. You completed this configuration in Define Member Node
in Administration Console.
Step 3
Step 4

Step 5

Step 6

Select OK at the screen.
In the Network Connectivity Test Configuration screen, you can verify the connection of this node to the
first node (the Controller).
Note
The Network Connectivity Test Configuration screen refers to the first node as the publisher, in
reference to its role in database replication. The first node publishes or replicates, the databases to
the Member nodes, which are referred to as subscribers of the database replication. Select No to open
the First Node Access Configuration screen.
In the First Node Access Configuration screen, enter connection values for the first node (the Controller):
a) Host Name of the Controller
b) IP Address of the Controller
c) Security Password (enter and confirm)
d) Select OK to open the SMTP Host Configuration screen.
In the SMTP Host Configuration screen, select whether you want to configure an SMTP host to receive
platform-level emails; for example, emails about certificate expiration. This field is optional. You configure
email for report scheduling in the Administration console.
If

Then

You want to configure an SMTP Host.

Select Yes to open the second SMTP screen.
Proceed to Step 7.

You do not want to configure an SMTP Host.

Select No to open the Platform Configuration
Confirmation screen.
Proceed to Step 8.

Step 7

In the second SMTP Host Configuration screen:
a) Enter the hostname or IP address for the SMTP server.
b) Select OK to open the Platform Configuration Confirmation screen.

Step 8

In the Platform Configuration Confirmation screen:
If

Then

You want to proceed.

Select OK.
The installation begins.

You want to revisit screens to modify the
configuration.

Select Back.
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Upgrades
This section explains how to upgrade Unified Intelligence Center software with engineering specials, minor
releases, and maintenance releases as they become available.
An upgrade typically happens in place and requires no hardware change. To continue with Upgrade, see
About Upgrades, on page 29. To upgrade, you must Download Unified Intelligence Center Upgrade File
and then apply it using Access Unified OS Administration .
• About Upgrades, page 29
• Download Unified Intelligence Center Upgrade File, page 30
• Refresh Upgrade , page 31
• Access Unified OS Administration , page 35
• Upgrade From DVD/CD, page 36
• Upgrade From Remote Filesystem, page 37
• Revert to Previous Version, page 38

About Upgrades
Note

From this release, to perform an upgrade of Unified Intelligence Center to 11.0(1), you must first perform
an upgrade to 10.x from the previous versions and then upgrade to 11.0(1). For information on upgrade
to 10.x, see http://www.cisco.com/c/en/us/support/customer-collaboration/unified-intelligence-center/
tsd-products-support-series-home.html
The upgrade takes less than 1 hour. Perform a DRS backup on the primary Unified Intelligence Center server.
To access the DRS application, direct your browser to https://IP address of Unified Intelligence Center
server:8443/drf. For more information, see the online help provided with the DRS application.
Before starting the software upgrade, back up your system data using the Disaster Recovery system application.
For more information about backup, see the Administration Console User Guide for Cisco Unified Intelligence
Center.
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Upgrade and restart the Controller node first. Then upgrade and restart the members. All nodes must be on
the same version of Unified Intelligence Center.
Two bootable partitions exist on your system: an active, bootable partition and an inactive, bootable partition.
The system boots up and operates entirely on the partition that is marked as the active partition. Upgrade
software installs on the inactive partition. The system continues to function normally on the active partition
during the upgrade installation on the inactive partition.
When you are ready, you initiate a Switch Version action. You can do this using a CLI command utils system
switch-version. You can also do it in the Cisco Unified OS Administration interface. The switch version action
activates the inactive partition. The system reboots to the newly active (formerly inactive) partition that is
running the new upgrade software. The preupgrade version of the software is in the inactive partition and
remains there until the next upgrade.
Your configuration information moves automatically to the upgraded version in the active partition.
All configuration information in Unified Intelligence Center 10.x are preserved across an upgrade to Unified
Intelligence Center 11.0(1), except in the case of the following scenario:

Procedure
Step 1
Step 2
Step 3
Step 4

Upgrade from 10.x to 11.0(1).
Perform a switchback to 10.x accordingly.
Log into Intelligence Center Administration page in 10.x and make new configuration changes.
Switch over to 11.0(1), the new configuration changes are not migrated when you switch over.

In the above scenario, if you make any configuration changes in 10.x release after a switchback, perform a
full upgrade to Unified Intelligence Center 11.0(1) to reflect all the configuration changes.

Note

Database changes are stored on the database in the active partition. The database on the inactive partition
does not get updated. If you make changes to the database after an upgrade and then decide to revert to
the pre-upgrade software on the inactive partition, you must repeat those changes after switching the
partition.

Note

Existing customers using VMware EXSi 4.x should first migrate to VMWare EXSi 5.1 or 5.5 before
upgrading to Unified Intelligence Center 11.0(1).

Download Unified Intelligence Center Upgrade File
You might receive an upgrade file directly from Cisco Systems, but in most cases, you must download the
file from the Cisco Systems Website.

Note

The download process on Cisco.com changes periodically. The following process was in place at the time
this Installation doc was prepared.
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Procedure
Step 1

Step 2
Step 3
Step 4

Step 5

Point your browser to the Download Software page for Cisco Unified Intelligence Center: http://
software.cisco.com/download/type.html?mdfid=282163829&i=rm, and click the Unified Intelligence Center
Software link.
Navigate to the folder and subfolder for the release you want.
Select the Unified Intelligence Center installer .iso file and click Download.
After successful log in, accept the license agreement and download/save the file to the desired location.
Note
Do not rename the file before you install it, because if you do, the system will not recognize it as a
valid file.
Note
Do not unzip or untar the file. If you do, the system may not be able to read the upgrade
files.
Make this file available on all nodes.

Refresh Upgrade
You can perform a refresh upgrade from 10.x to 11.0(1) on publisher and subscriber nodes of Unified
Intelligence Center. Before you begin upgrade, perform a backup, for more information see About Upgrades,
on page 29.

Note

VMware tools upgrade must be performed only on Unified Intelligence Center 10.x or 11.0(1). For Unified
Intelligence Center 10.x, upgrade the VMware tools before applying the refresh upgrade COP and changing
the virtual machine parameters Virtual Machine Parameters to Support Refresh Upgrade, on page 31.
For more information on VMware tools, see http://docwiki.cisco.com/wiki/VMware_Tools.

Upgrade VMware vSphere ESXi
If you use VMware vCenter Server in your deployment, upgrade VMware vCenter Server before upgrading
VMware vSphere ESXi.
Upgrade VMWare vSphere ESXi on Side A and Side B servers to the latest version supported with this release
of Packaged CCE. Packaged CCE uses standard upgrade procedures, which you can find using VMware
documentation (https://www.vmware.com/support/pubs/).

Virtual Machine Parameters to Support Refresh Upgrade
Before you perform a refresh upgrade to 11.x, modify the following virtual machine settings: Red Hat Enterprise
Linux version, Network Adapter, Memory and Video Card.

Installation and Upgrade Guide for Cisco Unified Intelligence Center Release 11.0(1)
31

Upgrades
Install the Upgrade COP File

Procedure
Step 1
Step 2

Step 4

Power down the virtual machine.
From VMWare VSphere, select the virtual machine > Edit Settings.
The Virtual Machine Properties window appears.
In the Options tab, select General Options and update the Guest Operating System from Red Hat Enterprise
Linux 4(32-bit) to Red Hat Enterprise Linux 6(64-bit). Click OK.
Again select the virtual machine > Edit Settings. In the Hardware tab, update the following parameters:
a) Memory > Memory Size > 10GB
Note
If you do not modify the memory size to 10GB, this message Warning! Old OVA detected.
Update your OVA displays post an upgrade in the Cisco Unified Intelligence Center
Administration and Command Line Interface page.
b) Video Card > Total Video Memory > 8MB

Step 5

Power on the virtual machine and continue with the refresh upgrade.

Step 3

Install the Upgrade COP File
Follow the steps to install the upgrade COP file using the Unified Intelligence Center Command line interface
(CLI).
You can also install the COP using the upgrade procedure in the Cisco Unified Operating System Administration
web interface. For details see the chapter on Access Unified OS Administration , on page 35 in the Unified
Intelligence Center Installation and Upgrade document.

Note

In a cluster setup, install the COP on the publisher node and restart it. Only then proceed with installation
on all the subscriber nodes.

Before You Begin
Unified Intelligence Center Release 10.x must be installed or upgraded on your system. Download the COP
file ciscocuic.refresh_upgrade_v1.4.cop.sgn from the download software page for Cisco
Unified Intelligence Center: https://software.cisco.com/download/type.html?mdfid=282163829&catid=null
to the SFTP server that can be accessed from the Unified Intelligence Center 10.x system.

Procedure
Step 1
Step 2
Step 3
Step 4

Log in to Unified Intelligence Center CLI and specify the System Administration username and password.
Enter the command utils system upgrade initiate to initiate the COP installation.
Select Remote File System from source list page.
Enter the remote path to the directory on the SFTP server where you have downloaded the COP file.
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If the COP file is located on a Linux or UNIX server, you must enter a forward slash (/) at the
beginning of the directory path. For example, if the COP file is in the patches directory, enter /patches.
If the COP file is located on a Windows server, check with your system administrator for the correct
directory path.
Enter the SFTP server name or IP address and then enter the credentials.
It is optional for you to enter the SMTP Host Server name.
Select the transfer protocol as SFTP. The system displays the list of COP files available in the SFTP location.
Select the number corresponding to the COP file that you want to install and press Enter.
Enter Yes when you are prompted to start installation. After COP installation, restart the box. If this is a single
node, your installation ends here.
In a cluster setup, if this installation was performed on a publisher node, restart the box and then proceed with
installation on the subscriber nodes (restart this procedure for every node in cluster).
Note

Step 5
Step 6
Step 7
Step 8
Step 9

Upgrade Unified Intelligence Center
Follow the steps to install the ISO file using the Unified Intelligence Center Command line interface (CLI).
You can also install the ISO using the upgrade procedure in the Cisco Unified Operating System Administration
web interface. For details see Access Unified OS Administration , on page 35 in the Unified Intelligence
Center Installation and Upgrade document.

Before You Begin
Before you begin the refresh upgrade, check if the COP ciscocuic.refresh_upgrade_v1.4.cop.sgn
is applied on the base version 10.x . Download the ISO file from the download software page for Cisco Unified
Intelligence Center: https://software.cisco.com/download/type.html?mdfid=282163829&catid=null to the
SFTP server that can be accessed from the Cisco Unified Intelligence Center 10.x system.

Procedure
Step 1
Step 2
Step 3
Step 4

Step 5
Step 6
Step 7
Step 8

Log in to Unified Intelligence Center CLI and specify the System Administration username and password.
Enter the command utils system upgrade initiate to initiate the ISO installation.
Select Remote File System from source list page.
Enter the remote path to the directory on the SFTP server where you have downloaded the ISO file.
Note
If the ISO file is located on a Linux or UNIX server, you must enter a forward slash (/) at the beginning
of the directory path. For example, if the COP file is in the patches directory, enter /patches. If the
ISO file is located on a Windows server, check with your system administrator for the correct directory
path.
Enter the SFTP server name or IP address and then enter the credentials.
It is optional for you to enter the SMTP Host Server name.
Select the transfer protocol as SFTP. The system displays the list of ISO files available in the SFTP location.
Select the number corresponding to the ISO file that you want to install and press Enter.
Enter yes when you are prompted Switch to new version if the upgrade is successful
(yes/no) and yes when you are prompted Start Refresh Upgrade (yes/no).
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Verify if the node is upgraded to 11.x, after successful switch version (where active version is 11.x
and inactive version is 10.x).
In cluster setup, first complete the refresh upgrade on the publisher node and perform the refresh upgrade on
the subscriber node. After successful upgrades, perform switch version using command utils system
switch-version first on the publisher node and later on the subscriber nodes .
Note
Verify if the nodes are upgraded to 11.x, after successful switch version of the publisher node and
subscriber nodes (where active version is 11.x and inactive version is 10.x ).
Note

Step 9

Upgrade VMware Tools
Use this procedure to upgrade VMware tools from the VMware vSphere Client followed by the CLI command.
To upgrade VMware tools for Cisco Unified Intelligence Center:

Procedure
Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

Power on the virtual machine.
Right-click the VM and select Guest > Install/Upgrade VMware Tools.
Select the Interactive Tools Upgrade option and click OK.
Open the administrator console and log in to command prompt.
Run the command utils vmtools refresh and confirm.
The server automatically reboots twice. This process takes a few minutes.
After reboot, from the vSphere client, select the VM and click the Summary tab.
Check for the VMware Tools status is “Running (Current)”.

Change NIC Adapter Type
Procedure
Step 1
Step 2
Step 3

Power down the virtual machine.
From VMware VSphere, select the virtual machine > Edit Settings.
The Virtual Machine Properties window appears.
To add the new Network Adapter, on the Hardware tab, click Add . The Add Hardware window appears.

Step 4

Select Device Type , Ethernet Adapter , Next . Select the adapter type VMXNET3 , Next, and click Finish.

Step 5

To remove the existing Network Adapter 1, under the Hardware tab, select Network Adapter 1 , click
Remove , and select OK .

Step 6

Power on the virtual machine.
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Support for Aligned Partitions
Unified Intelligence Center now supports aligned partitions, only if you perform a fresh install. If you perform
an upgrade from the previous release, the platform detects the unaligned partitions and displays the following
error: ERROR-UNSUPPORTED: Partitions unaligned
Unified Intelligence Center continues to function with unaligned partitions. However, to remove this error
and benefit from aligned partitions, perform a fresh installation.
To support aligned partitions following an upgrade, perform these steps:

Procedure
Step 1
Step 2

Upgrade Unified intelligence Center to 11.0.
Perform a backup on the primary server using the Disaster Recovery System (DRS) application. Direct your
browser to https://FQDN of cuic server:8443/drf to access the DRS application.

Step 3
Step 4

Perform fresh installation of Unified Intelligence Center 11.0.
Perform a restore from your backup using the DRS application. For more information on backup, see the
Administration Console User Guide for Cisco Unified Intelligence Center 11.0(1).

Access Unified OS Administration
To perform an upgrade from the Cisco Unified OS Administration application, follow the steps.
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Procedure
Step 1
Step 2
Step 3

Enter http://x.x.x.x/cmplatform, where x.x.x.x is the IP address of the node.
Sign in using the username and password of the system administrator account.
Select Software Upgrades > Install/Upgrade to display the Software Installation/Upgrade page.
Figure 5: Software Upgrade Page

Step 4

Select source: Upgrade From DVD/CD or Upgrade From Remote Filesystem.

Upgrade From DVD/CD
Follow these steps if a DVD/CD is the source for your install/upgrade.

Installation and Upgrade Guide for Cisco Unified Intelligence Center Release 11.0(1)
36

Upgrades
Upgrade From Remote Filesystem

Procedure
Step 1
Step 2
Step 3

Prepare a writeable DVD and insert it into the disc drive on the server that is to be upgraded.
Select DVD/CD from the Source list on the Software Upgrades > Install/Upgrade page.
In the Directory field, enter the path to the upgrade file.
If the file is in the root directory, enter a slash (/) in the Directory field.

Step 4
Step 5
Step 6

To continue the upgrade process, click Next.
Choose the upgrade version that you want to install and click Next.

Step 7
Step 8
Step 9

In the next window, monitor the progress of the download. If you encounter difficulties, see the Frequently
Asked Question section.
When the download completes, Click Next.
If you want to install the upgrade and automatically reboot to the upgraded partition, choose Reboot to
upgraded partition. The system restarts running the upgraded software.
If you want to install the upgrade and then manually reboot to the upgraded partition at a later time, do the
following:
a) Choose Do not reboot after upgrade.
b) Click Next. The Upgrade Status window displays the Upgrade log.
c) When the installation completes, click Finish.
d) To restart the system and activate the upgrade, choose Settings > Version, and then click Switch Version.
The system restarts running the upgraded software.

Step 10 Clear the browser cache before you start working on the new version of Unified Intelligence Center. For more
information about clearing the cache, see your browser specific documentation.

Upgrade From Remote Filesystem
Follow these steps if Remote Filesystem is the source for your install/upgrade.

Procedure
Step 1
Step 2

Choose Remote Filesystem from the Source list on the Software Upgrades > Install/Upgrade page.
Enter the path to the directory that contains the patch file on the remote system in the Directory field.
If the upgrade file is on a Linux or Unix server, you must enter a forward slash at the beginning of the directory
path. For example, if the upgrade file is in the patches directory, enter /patches. If the upgrade file is on a
Windows server, check with your system administrator for the correct directory path.
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Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

In the Server field, enter the server name or IP address.
In the User Name field, enter your username on the remote server.
In the User Password field, enter your password on the remote server.
Select the transfer protocol from the Transfer Protocol field.
To continue the upgrade process, click Next.

In the next window, monitor the progress of the download. If you encounter difficulties, see the Frequently
Asked Question section.
Step 9 When the download completes, click Next.
Step 10 If you want to install the upgrade and automatically reboot to the upgraded partition, choose Reboot to
upgraded partition. The system restarts running the upgraded software.
Step 11 If you want to install the upgrade and then manually reboot to the upgraded partition at a later time, do the
following:
a) Choose Do not reboot after upgrade.
b) Click Next. The Upgrade Status window displays the Upgrade log.
c) When the installation completes, click Finish.
d) To restart the system and activate the upgrade, choose Settings > Version, and then click Switch Version.
The system restarts running the upgraded software.
Note

It takes about half an hour to complete the Switch Version and the restart.

Step 12 Clear the browser cache before you start working on the new version of Unified Intelligence Center. For more
information about clearing the cache, see your browser specific documentation.

Revert to Previous Version
After upgrading, you can revert to the software version that was running before the upgrade, by restarting
your system and switching to the software version on the inactive partition.

Note

All nodes must be running the same version of Unified Intelligence Center. Reverting is an all-or-none
operation when you operate a cluster of Unified Intelligence Center nodes.

Pre-requisites to Revert to Versions 10.x
Before reverting to 10.x you have to follow the VM Parameter changes on CUIC 11.0(1).
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Procedure
Step 1
Step 2
Step 3

Power down the virtual machine.
From VMware VSphere, select the virtual machine > Edit Settings. The Virtual Machine Properties window
appears.
To add the new Network Adapter, on the Hardware tab, click Add . The Add Hardware window appears.

Step 4

Select Device Type, Ethernet Adapter, next select the adapter type E1000, next and click Finish.

Step 5

To remove the existing Network Adapter 1(VMXNET3), under the Hardware tab, select Network Adapter
1, click Remove and select OK .

Procedure to revert to previous version
You can do this in two ways. You can use the CLI command utils

system switch-version

on each node.

You can also use the user interface in the Unified OS Administration.
Follow these steps to revert using Unified OS Administration:

Procedure
Step 1
Step 2
Step 3

Open Unified OS Administration page entering the following URL: https://server-name/cmplatform, where
server-name is the hostname or IP address of the node.
Sign in using the system administrator credentials.
Choose Settings > Version.
This opens the Version Settings screen, which shows the software version on both the active and inactive
partitions. To switch versions and restart, click Switch Versions. When the system restarts, it boots to the
now-active (formerly inactive) partition with your migrated data in place.
Note

It takes about half an hour to complete the Switch Version and the restart.
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Frequently Asked Questions About Installation
• Frequently Asked Questions, page 41

Frequently Asked Questions
Can I install on a virtual machine?
Starting with Release 8.0(3), you can install Unified Intelligence Center on a virtual machine.
Can my Cisco Support Provider log in to assist me?
Yes. There is a utility that allows Cisco technicians to troubleshoot your system, its configurations, and
databases.
Set up and enable a time-limited access account to your system using the CLI commands under the
utils remote_account command or run the utility from the Cisco Unified Operating System
Administration Console (select Services > Remote Support).
The procedure to do this is documented in the online help for the Cisco Unified Operating System
Administration Console.
How do I handle “No Such File or Directory” error?
During installation on some servers, you might see an error similar to this:
rmmod: ohci_hcd: no such file or directory

This is a message related to USB driver modules and can be safely ignored.
The installation attempts to delete all modules on the server before loading new ones. If a module does
not exist on the server where the installation is running, a message indicates that there is no such file
to be deleted. Messages differ slightly for different driver names.
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How do I access log files?
If you encounter problems with the installation, you can obtain and examine the install log files by
entering the following commands in Command Line Interface.
• Enter the CLI command file
command line.

list install *

• Enter the CLI command file view install
line where log_file is the log file name.

to obtain a list of all install log files from the

<log_file> to view the log file from the command

Other ways to access log files are as follows:
• Use the CLI file dump commands.
• Use the Syslog Viewer in the Real-Time Monitoring Tool (RTMT). Download RTMT from the
Administration console (Tools > RTMT Plugin Download).
How do I add or replace devices in the cluster?
To add a device (for example, to add an additional Member to the cluster):
1 Verify that the virtual machine meets the hardware requirements.
2 Make sure that the other devices in the cluster are up and running.
3 Run a fresh (DVD) installation on the new or replacement device. It must be the same version of
Unified Intelligence Center that is currently installed on all other nodes.
4 Test that the new device can connect to the other devices in the cluster. See How do I test server
connectivity?.
How do I find the server MAC address?
You must supply the MAC address of the Controller node when you apply for a license to operate
Unified Intelligence Center.
The MAC Address appears online at the end of the installation. If you do not have time to write it down,
you can find it through the Command Line Interface, once the install is complete, as follows:
1 Sign in, using the System Administration user credentials.
2 Enter this CLI Command: show

status.

How do I sign in to the Administration Console?
1 Direct a browser to the URL for the administration console.
The URL is https://<HOST ADDRESS:8443/oamp/ where HOST ADDRESS is the IP
address or host name of your controller node with the default port.
2 Enter the System Application user ID and password that you defined during installation.
This person is the initial, default Super User.
Any Super Users who were added after the installation can also log in.
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How do I sign in to Unified Intelligence Center Reporting?
There are two ways to do this:
• From the browser:
1 Direct a browser to the URL for the reporting application.
The URL is https://<<host>:8444/cuicui/Main.jsp where HOST ADDRESS
is the IP address or host name of your member node.
2 Enter your login credentials.
• From the Administration Console:
1 Open the Control Center page.
2 Locate the Member you want to access.
3 Click the Member name to open the sign in page for that Member.
4 Enter your login credentials.
The System Application user ID and password defined during installation can log in to the Reporting
application. Any additional Login Users who have been created and authenticated can also log in.
How do I switch between Administration Console and Unified Intelligence Center Reporting?
If you are signed in to the Administration Console and wish to redirect your browser to the Unified
Intelligence Center Reporting web page:
1 Open Control Center > Device Control.
2 Locate the Member node you want to access.
3 Click the name for that Member node.
The name is a link that opens the sign in page for the node.
4 Enter your login credentials.
How do I access the Command-Line Interface?
You can access the CLI directly from any node, using the monitor and keyboard at the server console.
1 Enter the ID for the System Administrator account created during install.
See What accounts and passwords are defined during the installation?.
2 When prompted, enter the password for the System Administrator account.
The CLI is documented in the Administration Console User Guide for Cisco Unified Intelligence Center.
How do I test server connectivity?
There is a step to test network connectivity during the installation of the Controller and Member servers.
You can also run a basic check that one server can connect to another using this CLI command: utils
network ping. See Complete Configuration for Member Node, on page 27.
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How do I use the Recovery Disk?
The installation package includes a Recovery Disk on CD media to help you to recover from a
catastrophic failure, such as an unbootable system.
To use the Recovery Disk, insert it into the tray and boot up into it.
For more information on Server Recovery, see http://www.cisco.com/c/dam/en/us/td/docs/
voice_ip_comm/cucm/recovery_cd/Server_Recovery-README.pdf.

Note

The recovery disk menu option [A] [a] is not supported.

How do I uninstall?
There is no way to uninstall other than reinserting the installation DVD, which will reformat the hard
disk.
How is data handled during an upgrade?
Data migration occurs during an upgrade installation. This includes the database, configuration properties,
and licensing files. See Where is an upgrade installation installed?.

Warning

Do not make configuration changes from the start of the upgrade process until
you have activated the inactive partition and rebooted the system.

If you decide to downgrade or switch the system to the inactive partition that contains the older version
of the software, any configuration changes that you made since upgrading will be lost.
Is Unified Intelligence Center supported in a hosted deployment?
Yes, deployment in a hosted environment is qualified and tested. The deployments tested are Unified
Intelligence Center with Live Data, Live Data only and Unified Intelligence Center only.
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What if the installation fails?
If the installation fails, you see a screen asking if you want to copy diagnostic information to a device.
Figure 6: Installation Failed Screen

1 Insert a USB key.
2 Select Yes.
3 Select Continue at the next two screens.

Note

The CLI command to view the install logs is file view install. The CLI is
documented in the Administration Console User Guide for Cisco Unified
Intelligence Center.

If the installation fails over a virtual machine, you see a screen asking if you want to copy diagnostic
information to a device.
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Which accounts and passwords are defined during the installation?
During the installation, you specify three passwords: the System Administrator user, the System
Application user, and the database access security password. All three must start with an alphabetic
character, must be at least six characters long, and can contain alphanumeric characters, hyphens, and
underscores. Only the application user and password are passed to the online Administration console.
• System Administrator account: The System Administrator account User ID and password are
configured at installation for each node. It is a best practice to enter the same user name and
password for all nodes. The System Administrator for the Controller can access:
• The CLI for the Controller.
• The Cisco Systems tools on the Navigation dropdown in the Administration console: Disaster
Recovery System, Cisco Unified Serviceability, and Cisco Unified OS Administration
interfaces.
The System Administrator has no access to functions in the Unified Intelligence Center reporting
application.

Note

If you configure unique System Administrator credentials for Member nodes, you must
use those credentials to access the CLI for those Member servers only.

• System Application User account: The System Application account User ID and password are
configured at installation for each node. It is a best practice to enter the same user name and
password for all nodes.
The System Application user name and password that are configured for the Controller allow an
initial login to the Administration console. This user becomes that initial Super User and, once
the license is applied, can log in to the Unified Intelligence Center Reporting application on all
Member nodes.
As the initial Super User, the System Application User can create additional Super Users in the
User Management screen or by using the CLI command set account. This user can also sign in
to the Unified Intelligence Center Reporting interface with full access to all functions.
The initial Super User (the System Application user) created in the installation does not need to
be set up in Active Directory. Any additional Super Users created through the Administration
console are considered to be IMS users. They can sign into Unified Intelligence Center Reporting
and will be limited to the Login User role until they are given additional privileges.

Note

If you configure unique System Application credentials for Member nodes, those users
have no login rights.

• Security Password: The security password defined in the installation wizard is used by the
system for the database security password to authorize communications between devices. This
password is identical on all servers in the cluster. The security password is also used by the Disaster
Recovery System (DRS) for encryption of the backup file.
You can change the security password using the CLI command set password security.
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How do I dump install logs to the serial port of the virtual machine?
1 Configure a serial port on the virtual machine.
While the virtual machine is powered OFF, edit settings and add a serial port to the virtual machine.
You cannot add a serial port while the virtual machine is running. Attach the serial port to a .tmp
file, and then power on the virtual machine and start the install.
2 When you are ready to dump the log files, attach a new, empty file to the serial port.
If the system halts due to an install failure and asks if you want to dump the logs, before you answer
yes, you must edit settings on the virtual machine and attach the actual file name where you want
to dump the logs. The reason for originally attaching the .tmp file to the serial port is that during
the boot-up of Linux, a few garbage characters (terminal escape sequences) get output to that port.
If you dump the logs into that file, these characters will corrupt the .tar format of the file. In order
to create a valid .tar file, you must connect the serial port to a new and empty file just before you
dump the logs to it.
3 Return to the virtual machine console and proceed to dump the logs to the serial port.
After the file is complete, open it with 7-zip, which you can download from http://www.7-zip.org/
download.html.
4 After a successful install, power off the virtual machine, edit settings, and remove the serial port
from the virtual machine.
Important

Leaving the serial port (or any other virtual hardware) can negatively impact
performance of the virtual machine. The serial port has no other use other than
dumping the install logs and you will not need it again, unless you perform a
fresh install.

What do I do if the upgrade stalls?
During the installation of upgrade software, the upgrade may appear to stall. The upgrade log stops
displaying new log messages. When the upgrade stalls, you must cancel the upgrade, disable I/O
throttling, and restart the upgrade procedure. When you successfully complete the upgrade, you do not
need to reenable I/O throttling.
• To disable I/O throttling, enter the CLI command utils

iothrottle disable.

• To display the status of I/O throttling, enter the CLI command utils
• To enable I/O throttling, enter the CLI command utils
is enabled.

iothrottle status.

iothrottle enable. By default, iothrottle

If the system does not respond to the cancellation, you must reboot the server, disable I/O throttling,
and restart the upgrade process procedure.
Where is a fresh installation installed?
All Controller servers have an active bootable partition, an inactive bootable partition, and a common
partition. The installation creates these partitions, and a fresh (first-time) installation places the new
software and operating system on the active partition. The system boots up and operates on the active
partition.
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Where is an upgrade installation installed?
All Controller servers have an active bootable partition, an inactive bootable partition, and a common
partition. Upgrade versions are installed on the inactive partition.
To complete the upgrade, you switch partitions using the CLI command utils

system switch-version.

You can also do this from the Cisco Unified Communications Operating System Administration screen.
Navigate to Settings > Version. This opens the Version Settings screen, which shows the software
version on both the active and inactive partitions. To switch versions and restart, click Switch Versions.
When the system restarts, it boots to the now-active (formerly inactive) partition with your migrated
data in place. See Upgrades for more information.
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Unified Intelligence Center Licenses
For Unified Intelligence Center installations on Virtual Machines, the license is locked to the licensing MAC
of the Virtual Machine. The licensing MAC is different from the physical MAC address of the system. The
licensing MAC string is generated during installation and is based on various input fields, such as the
hostname, IP address, NTP server, and so forth.
A licensing MAC address change will require a new license. The license file is physically located on the
Controller node and is distributed to all members nodes in the cluster through database replication.
There can be only one license installed on a system at any point in time.
Uploading the license file is the first action the System Application User must take after installing the
Controller node.

Note

There is no license required for a Live Data only deployment.
After installation, and until the System Application User obtains and uploads a Standard or Premium license,
he or she:
• Can sign in to the Administration Console to view the Controller and to add the alias name.
• Cannot perform other Administration Console functions.
• Cannot sign in to the Unified Intelligence Center Reporting application.
• Cannot install member nodes.
• Acquire Your License, page 49
• Obtain the License, page 50
• Upload License, page 51
• Cisco Unified Intelligence Center Answer File Generator, page 51

Acquire Your License
To acquire a demo license:
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Procedure
Step 1
Step 2
Step 3
Step 4

Step 5

Go to the Cisco Product License Registration website at this URL: https://tools.cisco.com/SWIFT/LicensingUI/
Home.
If you do not have a PAK, write to licensing@cisco.com.
Scroll to Unified Communications Products and click Cisco Unified Intelligence Center version 8.0
Evaluation.
Enter your MAC address as a single string (with no spaces between the characters), accept the agreement,
and enter your Registrant Information.
In the case of Unified Intelligence Center installation over Virtual Machine, you need to provide the licensing
MAC. See Locate MAC Address.
Follow prompts to complete the registration pages.

You will receive the license file in an email from Cisco Systems. When you receive it, save it locally in a
location where it cannot be deleted by mistake or opened by an unauthorized person. In the event that your
system becomes corrupted, you can browse to this location to upload the license file again.
The same license file will be valid if you need to reapply it - unless you apply it to a new server with a new
MAC address.

Caution

License files are human-readable and can be opened. However, changing any text in the license file
invalidates the license.

Locate MAC Address
You must supply the MAC address of the Controller node when you apply for a license to operate Unified
IC.
The MAC address appears online at the end of the installation. If you do not have time to write it down, you
can find it through the Command Line Interface, once the install is complete, as follows:

Procedure
Step 1
Step 2

Sign in, using the credentials of the System Administration user.
Enter this CLI Command: show status.

Obtain the License
To obtain your production license:
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Procedure
Step 1

Step 2
Step 3
Step 4
Step 5

On the License Registration page at http://www.cisco.com/go/license enter the Product Authorization Key
(PAK) that comes with the Unified Intelligence Center product or that you received when you placed your
order.
Click Submit and follow instructions on the screen.
Enter the license MAC of the first node of the Unified Intelligence Center cluster.
Enter a valid email address and the number of nodes for which you need licenses.
Upload license to the server.

Upload License
Upload the license in the Unified IC Administration interface.

Procedure
To do this, select Cluster Configuration > License Management. Refer to the online help for instructions.

Cisco Unified Intelligence Center Answer File Generator
Unified Intelligence Center Answer File Generator, a web application, generates answer files for unattended
Unified Intelligence Center installations. Individual answer files get copied to the root directory of a USB key
or a floppy diskette and are used in addition to the Unified Intelligence Center DVD during the installation
process.
The web application supports the following features:
• Allows simultaneous generation and saving of answer files for unattended installs on the publisher server
and all subscriber servers.
• Provides syntactical validation of data entries.
• Provides online help and documentation.
The following usage requirements apply:
• The web application supports only fresh installs and does not support upgrades.
• If DHCP client is being used on the publisher server, and subscriber server answer files are also being
generated, you must specify the publisher server IP address.
You can access the Cisco Unified Communications Answer File Generator at the following URL:
http://www.cisco.com/web/cuc_afg/index.html
The Cisco Unified Communications Answer File Generator supports Internet Explorer version 10 and 11
(Compatibility View Mode), and Mozilla Firefox 38.0 ESR and above.
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Note

Cisco requires that you use USB keys that are compatible with Linux 2.6.32 You should use USB keys
that are preformatted to be compatible with Linux 2.6.32 for the configuration file. These keys will have
a W95 FAT32 format.
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Language Pack for Unified Intelligence Center
• Install Language Pack, page 53

Install Language Pack
Post successful install or upgrade, if you want to use the Cisco Unified Intelligence Center (CUIC) interface
in a language other than English, you have to download and install the language pack cop.
The language pack for CUIC is delivered as a single Cisco Option Package (COP) file. The file is available
to download from Cisco.com and contains a single installer for all language variants.
You can download the language pack for CUIC at the following link:
https://software.cisco.com/download/
release.html?mdfid=282163829&softwareid=282377062&release=11.5(1)&flowid=73207
COP files can generally be installed on an active, running system. However, language COP files cannot be
removed or rolled back.

Procedure
Step 1

Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

Download the CUIC Language Pack COP file from the Cisco Software site
https://software.cisco.com/download/release.html?mdfid=282163829&softwareid=282377062&release=11.5(1)&flowid=73207
to a local source or an SFTP server that can be accessed by the CUIC server.
Use SSH to log in to your CUIC system with the platform administration account.
Use the CLI to run the command utils system upgrade initiate.
Follow the instructions provided by the utils system upgrade initiate command.
Reboot the server.
Repeat step 2 through step 5 on the secondary CUIC server.
When the installation is complete on both CUIC servers, and all CUIC users must clear their browser cache
and cookies.
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